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Copyright and Legal Disclaimer
Copyright © 2006-2008 Dialogic Corporation. All Rights Reserved. You may not reproduce this document in whole or in part 
without permission in writing from Dialogic Corporation at the address provided below.

All contents of this document are furnished for informational use only and are subject to change without notice and do not 
represent a commitment on the part of Dialogic Corporation or its subsidiaries ("Dialogic"). Reasonable effort is made to ensure 
the accuracy of the information contained in the document. However, Dialogic does not warrant the accuracy of this information 
and cannot accept responsibility for errors, inaccuracies or omissions that may be contained in this document.

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH DIALOGIC® PRODUCTS. NO LICENSE, EXPRESS OR 
IMPLIED, BY ESTOPPEL OR OTHERWISE, TO ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT 
AS PROVIDED IN A SIGNED AGREEMENT BETWEEN YOU AND DIALOGIC, DIALOGIC ASSUMES NO LIABILITY WHATSOEVER, 
AND DIALOGIC DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF DIALOGIC PRODUCTS 
INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR PURPOSE, MERCHANTABILITY, OR 
INFRINGEMENT OF ANY INTELLECTUAL PROPERTY RIGHT OF A THIRD PARTY.

Dialogic products are not intended for use in medical, life saving, life sustaining, critical control or safety systems, or in nuclear 
facility applications.

It is possible that the use or implementation of any one of the concepts, applications, or ideas described in this document, in 
marketing collateral produced by or on web pages maintained by Dialogic may infringe one or more patents or other intellectual 
property rights owned by third parties. Dialogic does not provide any intellectual property licenses with the sale of Dialogic 
products other than a license to use such product in accordance with intellectual property owned or validly licensed by Dialogic 
and no such licenses are provided except pursuant to a signed agreement with Dialogic. More detailed information about such 
intellectual property is available from Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada 
H4M 2V9. Dialogic encourages all users of its products to procure all necessary intellectual property licenses 

required to implement any concepts or applications and does not condone or encourage any intellectual property 

infringement and disclaims any responsibility related thereto. These intellectual property licenses may differ 

from country to country and it is the responsibility of those who develop the concepts or applications to be aware 

of and comply with different national license requirements. 

Dialogic, Dialogic Pro, Brooktrout, Cantata, SnowShore, Eicon, Eicon Networks, Eiconcard, Diva, SIPcontrol, Diva ISDN, TruFax, 
Realblocs, Realcomm 100, NetAccess, Instant ISDN, TRXStream, Exnet, Exnet Connect, EXS, ExchangePlus VSE, Switchkit, 
N20, Powering The Service-Ready Network, Vantage, Connecting People to Information, Connecting to Growth, Making 
Innovation Thrive, and Shiva, among others as well as related logos, are either registered trademarks or trademarks of Dialogic. 
Dialogic's trademarks may be used publicly only with permission from Dialogic. Such permission may only be granted by 
Dialogic's legal department at 9800 Cavendish Blvd., 5th Floor, Montreal, Quebec, Canada H4M 2V9. Any authorized use of 
Dialogic's trademarks will be subject to full respect of the trademark guidelines published by Dialogic from time to time and 
any use of Dialogic's trademarks requires proper acknowledgement. 

Windows, Windows Server, and Microsoft are registered trademarks of Microsoft Corporation in the United States and/or other 
countries.  The names of actual companies and products mentioned herein are the trademarks of their respective owners. 
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Dialogic Corporation License Agreement for Use of Software 
This is an Agreement between you, the Company, and your Affiliates (referred to in some instances as "You" and in other 
instances as "Company") and all Your Authorized Users and Dialogic Corporation ("Dialogic").

YOU SHOULD CAREFULLY READ THE SOFTWARE LICENSE AGREEMENT ("AGREEMENT") ON THIS SEALED PACKAGE BEFORE 
OPENING THE PACKAGE. BY OPENING THE PACKAGE, YOU ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF 
YOU DO NOT AGREE WITH OR ARE UNWILLING TO ACCEPT THESE

TERMS AND CONDITIONS, YOU MAY RETURN THE PACKAGE IN UNOPENED "AS NEW" CONDITION (INCLUDING ALL 
DOCUMENTATION AND BINDERS OR OTHER CONTAINERS) FOR A FULL REFUND. BY DOWNLOADING, INSTALLING, COPYING 
OR OTHERWISE USING THE ENCLOSED SOFTWARE ("PROGRAM"), YOU FURTHER AGREE AND ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT AND UNDERSTAND IT, AND THAT BY TAKING ANY ONE OR MORE OF SUCH STEPS/ACTIONS 
YOU AGREE TO BE BOUND BY SUCH TERMS AND CONDITIONS.  DIALOGIC IS UNWILLING TO LICENSE THE SOFTWARE TO 
YOU IF YOU DO NOT ACCEPT AND AGREE TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS AGREEMENT.

Intellectual Property

The enclosed Software ("Program") and all accompanying documentation are individually and collectively owned by Dialogic 
Corporation ("Dialogic"), its subsidiaries and/or its suppliers and are protected by all applicable intellectual property laws and 
international treaty provisions. Therefore, You and Your Authorized Users must treat the Program and documentation like any 
other material so protected, except as expressly permitted in this Agreement.  In particular, but without limitation, You 
acknowledge that the Program and its accompanying documentation constitute valuable intellectual property rights, including 
without limitation trade secrets and copyrights, and confidential information of Dialogic. The Program and all programs 
developed thereunder and all copies thereof (including without limitation translations, compilations, partial copies with 
modifications and updated works) are proprietary to Dialogic and title to all applicable copyrights, trade secrets, patents and 
other intellectual property rights therein remains in Dialogic, its subsidiaries, and/or its suppliers. Except as expressly permitted 
in this Agreement, You shall not sell, transfer, publish, disclose, display or otherwise make available the Program or copies 
thereof to others. You agree to secure and protect the Program, its accompanying documentation and copies thereof in a 
manner consistent with the maintenance of Dialogic's rights therein and to take appropriate action by instruction or agreement 
with Your employees and/or consultants who are permitted access to the Program to satisfy Your obligations hereunder. 
Violation of any provision of this paragraph shall be the basis for immediate termination of this Agreement. Because 
unauthorized use or transfer of the Software or documentation may diminish substantially the value of such materials and 
irrevocably harm Dialogic, if You breach the provisions of this Section of this Agreement, Dialogic shall be entitled to injunctive 
and/or other equitable relief, in addition to other remedies afforded by law, to prevent a breach of this Section of this Agreement.

Grant of License

Subject to the terms and conditions of this Agreement Dialogic grants to You a non-exclusive, personal, non-transferable 
license to use the Program in object code form only and solely in accordance with the following terms and conditions:

• You may make, install and use only one (1) copy of the Program on a single-user computer, file server, or on a workstation 
of a local area network, and only in conjunction with a legally acquired Dialogic® hardware or software product You may 
also make one copy solely for backup or archive purposes;

• The primary Authorized User on the computer on which the Program is installed may make a second copy for his/her 
exclusive use on either a home or portable computer;

• You may copy the Program into any machine readable or printed form for backup or modification purposes in support of 
Your use of one copy of the Program;

• You may distribute the Program in object code only and only as part of, or integrated by You into, a computer system that 
(i) contains a Dialogic hardware product, (ii) includes a substantial amount of other software and/or hardware manufactured 
or marketed by You and (iii) is marketed and sublicensed to an end user for the end user's own internal use in the regular 
course of business (a "Licensed System");

• Each end user to whom a Licensed System is distributed must agree to license terms with respect to the Program that are 
at least as protective of Dialogic's rights in the Program as those set forth in this Agreement;

• You shall receive one (1) Program master disk, and shall be solely responsible for copying the Program into the Licensed 
Systems and for warranting the physical media on which it is copied

• You may make one (1) copy of the documentation accompanying the Program, provided that all copyright notices contained 
within the documentation are retained;

• You may modify the Program and/or merge it into another Program for Your use in one computer; (any portion of this 
Program will continue to be subject to the terms and conditions of this Agreement);

• You may transfer the Program, documentation and the license to another eligible party within Your Company if the other 
party agrees to accept the terms and conditions of this Agreement. If You transfer the Program and documentation, You 
must at the same time either transfer all copies whether in printed or machine readable form to the same party or destroy 
any copies not transferred; this includes all modifications and portions of the Program contained in or merged into other 
Programs;
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• You shall not remove, and each copy of the Program shall contain, the same copyright, proprietary, patent and/or other 
applicable intellectual property or other ownership notices, plus any restricted rights legends that appear in the Program 
and/or this Agreement and, if You copy the Program onto media to which a label may be attached, You shall attach a label 
to the media that includes all such notices and legends that appear on the Program master disk and envelope;

• You may not rent or lease the Program. You may not reverse engineer, decompile or disassemble the Program. Except as 
is strictly necessary for You to integrate the Program with other software and/or hardware to produce the Licensed Systems, 
You shall not copy, modify or reproduce the Program or documentation in any way. You shall use Your best efforts to ensure 
that any user of the Program does not reverse engineer, decompile or disassemble the Program to derive a source code 
equivalent of the Program;

• If You transfer possession of any copy, modification or merged portion of the Program or documentation to another party 
in any way other than as expressly permitted in this Agreement, this license is immediately and automatically terminated;

• The Program may be used only in conjunction with Dialogic hardware;

• The Program shall not be exported or re-exported in violation of any export provisions of the United States or any other 
applicable jurisdiction.

Upgrades

If the Program is provided as an upgrade and the upgrade is an upgrade from another product licensed to You and Your 
Authorized Users by Dialogic, the upgrade is governed by the license agreement earlier provided with that software product 
package and the present Agreement does not grant You additional license(s).

Term

The Agreement is effective until terminated. You may terminate it at any time by notifying Dialogic and/or by destroying the 
Program and all accompanying documentation together with all copies, modifications and merged portions in any form. The 
Agreement will also terminate automatically upon the occurrence or lack of occurrence of certain terms and/or conditions set 
forth in this Agreement, or if You fail to comply with any term or condition of this Agreement. You agree that upon any such 
termination You shall destroy or return to Dialogic the Program and all accompanying documentation supplied by Dialogic, 
together with any and all copies, modifications and merged portions in any form. All provisions of this Agreement relating to 
disclaimers of warranties, limitation of liability, remedies, or damages, and licensor's proprietary rights shall survive 
termination.

Limited Warranty

Dialogic solely warrants the media on which the Program is furnished to You to be free from defects in materials and 
workmanship under normal use for a period of ninety (90) days from the date of purchase by You as evidenced by a copy of 
Your receipt. If such a defect appears within the warranty period, You may return the defective media to Dialogic for replacement 
without charge provided Dialogic, in good faith, determines that it was defective in materials or workmanship.  Replacement 
is Your sole remedy with respect to such a defect.  Dialogic offers no warranty for Your reproduction of the Program. This 
Limited Warranty is void if failure of the Program has resulted from accident, misuse, abuse or misapplication.

Disclaimers, Limitations of Liability and Customer Remedies

Except as set forth in the "Limited Warranty" Section of this Agreement, the Program and accompanying documentation are 
provided to You "as is." Neither Dialogic, its subsidiaries, its suppliers, nor its licensor(s) (if any) warrants that the Program 
will meet Your requirements or that its use will be uninterrupted or error-free. Except as set forth in the "Limited Warranty" 
Section, EACH OF DIALOGIC, ITS SUBSIDIARIES, ITS SUPPLIERS AND ITS LICENSOR(S) (IF ANY) DISCLAIMS ANY AND ALL 
REPRESENTATIONS AND WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THE PROGRAM AND ACCOMPANYING 
DOCUMENTATION, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR AGAINST LATENT DEFECTS. Except as set forth in the "Limited Warranty" Section, 
neither Dialogic, its subsidiaries, its suppliers, nor its licensor(s) (if any) shall have any liability to You or any third party for 
any claim, loss or damage of any kind, including but not limited to lost business profits, business interruption, loss of 
information, or other pecuniary loss and indirect, punitive, incidental, economic, consequential or special damages, arising 
out of or in connection with this Agreement and/or the use, inability to use the Program and/or the Program's performance 
or inability to perform nor from or in connection with the Program's accompanying documentation, or any data or equipment 
related thereto or used in connection therewith. In no event shall Dialogic's, its subsidiaries', its suppliers' or its licensor(s)'s 
liability for damages, whether arising out of contract, negligence, warranty, or patent or copyright infringement, exceed the 
fees You paid for the Program. No representation or warranty regarding the Program may be made without Dialogic's, its 
subsidiaries', its suppliers', or its licensor(s)'s (if any) prior written consent, and any warranty or representation made by You 
or Your customers regarding the Program shall not constitute an obligation of Dialogic, its subsidiaries, its suppliers, or other 
licensor(s) (if any). This limited warranty gives You specific legal rights. You may have other rights, which may vary from 
jurisdiction to jurisdiction.  Also, as some jurisdictions do not allow the exclusion or limitation for certain damages, some of 
the above limitations may not apply to You.
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Right to Audit

If this Program is licensed for use in a Company, Your Company and You individually and collectively agree to keep all usual 
and proper records and books of accounts and all usual proper entries relating to each installation of the Program during the 
term of this Agreement and for a period of three (3) years thereafter. During this period, Dialogic may cause an audit to be 
made of the applicable records in order to verify Your compliance with this Agreement and prompt adjustment shall be made 
to compensate for any errors or omissions disclosed by such audit. Any such audit shall be conducted by an independent 
certified public accountant selected by Dialogic and shall be conducted during the regular business hours at Your offices and 
in such a manner as not to interfere with Your normal business activities. Any such audit shall be paid for by Dialogic unless 
material discrepancies are disclosed. For such purposes, "material discrepancies" shall mean three percent (3%) or more of 
the Authorized Users within the Company. If material discrepancies are disclosed,

Your Company agrees to pay Dialogic for the costs associated with the audit as well as the license fees for the additional 
licensed channels or additional authorized users. In no event shall audits be made more frequently than semi-annually unless 
the immediately preceding audit disclosed a material discrepancy.

Supplementary Software

Any Supplementary Software provided with the Program and/or referred to in this Agreement is provided "as is" with no 
warranty of any kind.

Miscellaneous

You acknowledge that You have read this Agreement, that You understand it, and that You agree to be bound by its terms 
and conditions, and You further agree that this is the complete and exclusive statement of the Agreement between the Dialogic 
and You ("the Parties"), which supersedes and merges all prior proposals, understandings and all other agreements, oral and 
written, between the Parties relating to the Program. You agree to indemnify and hold harmless Dialogic and its subsidiaries, 
affiliates, suppliers, officers, directors and employees from and against any claim, injury, loss or expense, including reasonable 
attorneys' fees, arising out of (i) Your failure to comply with the provisions of this Agreement, or (ii) any other wrongful conduct 
by or on behalf of You. This Agreement applies to all updates, future releases, modifications and portions of the Program 
contained in or merged into other programs. This Agreement may not be modified or altered except by written instrument 
duly executed by Dialogic. No action, regardless of form, arising out of this Agreement or the use of the Program may be 
brought by You more than two (2) years after the cause of action has first arisen. Except as provided herein, neither this 
Agreement nor any rights granted are assignable or transferable, and any assignment or transfer will be null and void. If You 
authorize any other person to copy the Program, You shall obligate that person in writing to comply with all conditions of this 
Agreement. Dialogic shall have the right to collect from You its reasonable expenses incurred in enforcing this agreement, 
including attorney's fees. The waiver or failure of Dialogic to exercise in any respect any right provided for herein shall not be 
deemed a waiver of any further right hereunder. All rights and remedies, whether conferred hereunder or by any other 
instrument or law, will be cumulative and may be exercised singularly or concurrently. Failure by either Dialogic or You to 
enforce any term or condition of the Agreement will not be deemed a waiver of future enforcement of that or any other term 
or conditions. The terms and conditions stated herein are declared to be severable. Should any term(s) or condition(s) of this 
Agreement be held to be invalid or unenforceable the validity, construction and enforceability of the remaining terms and 
conditions of this Agreement shall not be affected. It is expressly agreed that Dialogic and You are acting as independent 
contractors under this Agreement. These terms and conditions will prevail notwithstanding any different, conflicting or 
additional terms and conditions that may appear on any other agreement between Dialogic and You.  Deviations from these 
terms and conditions are not valid unless agreed to in writing in advance by an authorized representative of Dialogic. Any 
notices sent to Dialogic under this Agreement must be sent by registered mail or courier to the attention of Dialogic's legal 
department at the address below or such other address as may be listed on www.dialogic.com from time to time as being 
Dialogic's Montreal headquarters.

U.S. Government Restricted Rights

The Program and all accompanying documentation are provided with RESTRICTED RIGHTS. Use, duplication or disclosure by 
the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(iii) of The Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer 
Software-Restricted Rights at 48 CFR52.227-19, both as applicable.

Governing Law

Any and all claims arising under this Agreement shall be construed and controlled by the laws in force in the Province of 
Quebec, Canada, excluding its principles of conflict of laws and the United Nations Convention on Contracts for the Sale of 
Goods. Dialogic is not obligated under any other agreements unless they are in writing and signed by an authorized 
representative of Dialogic.

Contractor/ manufacturer is:

Dialogic CORPORATION.

9800 Cavendish Blvd., Montreal, Quebec, Canada H4M 2V9

This Agreement has been drafted in English at the express wish of the parties. Ce contrat a été rédigé en anglais à la demande 
expresse des parties.
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Dialogic Corporation End User Hardware Product(s) Warranty Statement
Dialogic Corporation End User Hardware Product(s) Warranty Statement 

Unless Your rights have been modified through the direct agreement between Dialogic Corporation ("DIALOGIC") and 
DIALOGIC's direct customer through whom You purchased Your DIALOGIC Hardware Product(s) Your warranty rights are set 
out in full as follows: 

DIALOGIC or its subsidiary that originally sold the hardware product(s) warrants to the original purchaser of the hardware 
product(s)  that at the time of delivery the hardware product(s) will be free from defects in material and workmanship. The 
warranty period for Your hardware product(s) will be for the standard period set forth on DIALOGIC's web-site at: 
http://www.dialogic.com/warranties as of the date You purchased the product. This warranty is void if the defect has resulted 
from accident, misuse, abuse or misapplication. Any hardware product which becomes defective during the warranty period 
and is returned by the original purchaser to DIALOGIC's Authorized Service Center with a Return Material Authorization (RMA) 
number (which must be obtained from DIALOGIC before any return) within thirty (30) days after discovery of the defect and 
with an accompanying written description of the defect will be replaced at DIALOGIC's option. Freight charges will be paid by 
DIALOGIC only for shipment back to you. 

Additional Exclusions:  DIALOGIC will have no obligation to make repairs or replacements necessitated by your fault or 
negligence, improper or unauthorized use of the product, repairs or modifications made without DIALOGIC's prior written 
approval or by causes beyond the control of DIALOGIC, including, but not limited to, power or air conditioning failure, acts of 
God, improper interface with other units, or malfunction of any equipment or software used with the DIALOGIC product(s). 
If DIALOGIC is requested and agrees to make repairs or replacements necessitated by any such causes, you will pay for such 
service or replacement at DIALOGIC's then prevailing rates. 

No Other Warranties:  DIALOGIC DISCLAIMS AND YOU WAIVE ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A 
PARTICULAR PURPOSE AND ANY WARRANTY AGAINST LATENT DEFECTS, WITH RESPECT TO ANY DIALOGIC PRODUCT.  

No Liability for Damages:  IN NO EVENT SHALL DIALOGIC OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER 
(INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, INTERRUPTION OF ACTIVITIES, LOSS OF 
INFORMATION OR OTHER PECUNIARY LOSS AND DIRECT OR INDIRECT, CONSEQUENTIAL, INCIDENTAL, ECONOMIC OR 
PUNITIVE DAMAGES) ARISING OUT OF THE USE OF OR INABILITY TO USE ANY DIALOGIC PRODUCT. 

Limitation of Liability: DIALOGIC'S MAXIMUM CUMULATIVE LIABILITY SHALL BE LIMITED TO THE AMOUNTS ACTUALLY PAID 
BY YOU TO DIALOGIC FOR THE SPECIFIC PRODUCT BEING THE OBJECT OF THE CLAIM.  YOU RELEASE DIALOGIC FROM ALL 
AMOUNTS IN EXCESS OF THE LIMITATION.  YOU  ACKNOWLEDGE THAT THIS CONDITION IS ESSENTIAL AND THAT DIALOGIC 
WOULD NOT SUPPLY TO YOU IF IT WERE NOT INCLUDED.

http://www.dialogic.com/warranties
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Dialogic® 3000 and 4000 Media Gateway Series Quickstart Guide

This document describes the installation and configuration of the Dialogic® 3000 Media Gateway Series and the 
Dialogic® 4000 Media Gateway Series. The term "Dialogic® 3000 Media Gateways" is used herein to refer 
collectively to the Dialogic® 3000 Media Gateway Series and the term "Dialogic® 3000 Media Gateway" is used 
herein to refer to a gateway in the Dialogic® 3000 Media Gateway Series.  Also, the term "Dialogic® 4000 Media 
Gateways" is used herein to refer collectively to the Dialogic® 4000 Media Gateway Series and the term 
"Dialogic® 4000 Media Gateway" is used herein to refer a gateway in the Dialogic® 4000 Media Gateway Series. 

This document assumes that the user is familiar with the Windows® operating system and its configuration, and 
therefore it does not describe the Windows configuration step by step.

Server System

The Dialogic® 4000 Media Gateway Series uses an Intel IP Network Server NSW 1U-R as server system. For 
more information regarding this hardware, see the Intel web site at www.intel.com.

Available Dialogic® Media Gateway Versions

The following Dialogic Media Gateways are available:

Note:  The Dialogic® 4000 Media Gateways include the option to activate a default fax license for 12 channels. 
If you need more channels, you are required to purchase a license. For more information about licenses, see 
License Activation on the Dialogic® 4000 Media Gateway Series on page 13.

Pre-installed Operating System

The following operating systems are pre-installed on the Dialogic Media Gateways:

• Dialogic 3000 Media Gateways: Windows® XP 32-bit 

• Dialogic 4000 Media Gateways: Windows Server® 2003 R2 32-bit

Software Components

The following Dialogic® Diva® software is pre-installed on the Dialogic® Media Gateways:

• Dialogic® Diva® System Release 8.5WIN Service Update 1: It includes the necessary Dialogic® Diva® Media 
Board installation, configuration, tracing, and line testing utilities.

• Dialogic® Diva® SIPcontrolTM 1.6 Service Update 1: It includes the necessary SIP to PSTN gateway module 
installation including a web-based gateway configuration.

Additionally, the Dialogic® 4000 Media Gateways are supplied with the following Microsoft® software:

• Microsoft® Office Communications Server 2007 Mediation Server

• Microsoft® Network Monitor 3.1 installation package

For more information about Dialogic 4000 Media Gateways and Microsoft® Unified Communications, see 
www.dialogic.com/microsoftuc.

For both the Dialogic® 3000 and 4000 Media Gateway Series, see the Dialogic web site for any product updates. 

Also, for both Media Gateway Series, you can add Remote Call Control via third party software. Contact your 
Dialogic partner or the Dialogic sales team for more information.

Version Media Boards installed Channels Voice Channels Fax

3008 1 x Dialogic® Diva® 4BRI-8 8 8

3016 2 x Dialogic® Diva® 4BRI-8 16 16

4060 1 x Dialogic® Diva® V-2PRI/E1/T1 60 12 - 60 (separate license needed; see note below)

4120 1 x Dialogic® Diva® V-4PRI/E1/T1 120 12 - 120 (separate license needed; see note below)

http://www.dialogic.com/microsoftuc
http://www.intel.com/design/telecom/products/cbp/ipserver/9979/overview.htm
http://www.intel.com/design/telecom/products/cbp/ipserver/9979/overview.htm


General Safety Instructions 

page 10 

General Safety Instructions 

WARNING • To help prevent electric shock, plug the gateway's power cables into properly grounded 
electrical outlets. Do not use adapter plugs or remove the grounding prong from a cable. If 
you must use an extension cable, use a three-wire cable with properly grounded plugs.

• The voltage and current rating of the cable should be greater than the ratings marked on the 
product.

• Do not spill food or liquids on your gateway, and never operate the product in a wet 
environment. 

• Do not push any objects into the openings of your gateway. Doing so can cause fire or electric 
shock by shorting out interior components.

• Never install telephone jacks in wet locations.

• Never touch non-insulated telephone wires or terminals unless the telephone line has been 
disconnected at the network interface.

• Use caution when installing or modifying telephone lines.

INFORMATION • Do not open the gateway box! Otherwise the warranty voids.

• Use only power cables approved for the use in your country. 

• To help protect your gateway from transient increases and decreases in electrical power, use 
a surge suppressor, line conditioner, or uninterruptible power supply (UPS).

• Keep your gateway away from radiators and heat sources. Also, do not block cooling vents.

• Cables for Interface ports used for the Dialogic® 4000 Media Gateway Series shall be shielded.
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Installation

The installation depends on the Dialogic® Media Gateway Series:

• For the Dialogic® 3000 Media Gateway Series, see below.

• For the Dialogic® 4000 Media Gateway Series, see page 12.

Installation of a Dialogic® 3000 Media Gateway

Note:  If you configure the Media Gateway via remote access, you do not need a keyboard, a mouse, or a monitor.

1. Take the Dialogic® 3000 Media Gateway and identify its ports at the rear panel:

• A: ports of the Dialogic® Diva® Media Board. The above graphic shows a Dialogic® 3008 Media Gateway; 
therefore, the four ports of one Dialogic® Diva® 4BRI-8 Media Board are displayed. 

• B: VGA port for the monitor,

• C: power supply,

• D: two USB ports for mouse and keyboard,

• E: two Ethernet ports.

2. Connect the mouse and keyboard to the USB ports.

3. Connect one end of the Ethernet cable to the active Ethernet port and the other end to the Ethernet. The 
active Ethernet port is the port at the right, next to the VGA port.

4. Connect the monitor to the VGA port. 

5. Plug one end of the ISDN cables into the ports of the Diva Media Board. Plug the other ends into the ports 
of the PBX. The ports of the Diva Media Board are numbered from 1 to 4 from the left to the right as shown 
in the graphic above. The port numbers may be important during the software configuration.

6. Plug one end of the power cord into the connector to the power supply of the Dialogic 3000 Media Gateway. 
Connect the other end to power source. 

7. Switch on the Media Gateway.

8. Observe the initial status of the LEDs. For the description of each LED, see LED indicators on page 24.
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Installation of a Dialogic® 4000 Media Gateway

1. Take the Dialogic® 4000 Media Gateway and identify its ports:

• A: ports of the Dialogic® Diva® Media Board: The above graphic shows a Dialogic® 4120 Media Gateway; 
therefore, the four ports of a Dialogic® Diva® V-4PRI/E1/T1 are displayed.

• B: power supply,

• C: redundant power supply,

• D: two PS/2 ports, 

• E: VGA port for the monitor,

• F: two USB ports for mouse and keyboard,

• G: four Ethernet ports.

2. Connect the mouse and keyboard to the USB or PS/2 ports.

3. Connect one end of the Ethernet cable to the Ethernet port 1 and the other end to the corporate Ethernet. 
For fault tolerance and load balancing, also connect a cable to Ethernet port 2 the same way. See the above 
graphic above for the numbering of the ports.

4. Connect the monitor to the VGA port. 

5. Plug one end of the T1/E1 cables into the ports of the Diva Media Board. Plug the other end into the ports 
of the PBX. The ports of the Diva Media Board are numbered from 4 to 1 from the left to the right as shown 
in the graphic above. The port numbers may be important during the software configuration.

6. Plug one end of the power cord into the power supply. Connect the other end to power source. Connect the 
second power cord the same way. It is recommended to connect both power supplies to ensure proper 
functioning of the Dialogic 4000 Media Gateway. 

7. Switch on the Dialogic 4000 Media Gateway.

Initial Log On

The initial configuration allows the unit to be configured using a remote desktop connection. 

The Dialogic® 3000 Media Gateway Series is initially configured with:

• Ethernet port 0 (next to VGA connector): with fixed IP address 192.168.1.1

• Ethernet port 1: disabled

• System name: DMG30<XX>-<XXXXX> (30<XX> -> XX stands for the version number, i.e., 08 or 16, XXXXX 
-> stands for the last five digits of the serial number)

The Dialogic® 4000 Media Gateway Series is initially configured with:

• Ethernet port 1 and 2: with fixed IP address 192.168.1.1 

• Ethernet port 3 and 4: disabled

Note: The above numbering of the Ethernet ports refers to the numbering at the rear panel of the Media 
Gateway and not to the numbering displayed in the Control Panel of your operating system.

• System name: DMG4<XXX>-<XXXXX> (4<XXX> -> XXX stand for the version number, i.e., 060 or 120,  
XXXXX -> stand for the last five digits of the serial number)
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Both Dialogic® 3000 and 4000 Media Gateways Series are configured with:

• User name: Dialogic

• Password: Dialogic (Change the password after the initial log on.)

Preparations for Configuration

Before you start to configure your Dialogic® Media Gateway, it is necessary to gather some information about 
the environment in which it will be used. 

Collect the following information:

1. In case the gateway is to be connected to a PBX: Which vendor and which PBX type will be used?

2. What protocol will be used on the PSTN/PBX side of the gateway? Examples are EuroISDN (ETSI-DSS1), 
Q-SIG, and DMS100.

3. What type of SIP endpoint are you using? Examples are Microsoft® Exchange Server 2007 UM or Microsoft® 
Office Communications Server 2007 (OCS).

License Activation on the Dialogic® 4000 Media Gateway Series

If you purchased a gateway from the Dialogic 4000 Media Gateway Series and want to use one or more of the 
the following functionalities:

• V.17 fax,

• V.34 fax, or

• V.90 modem 

available with the installed Dialogic® Diva® Media Board, you need to activate a license. Together with the 
Dialogic 4000 Media Gateway Series, Dialogic provides a default license for V.17 fax on 12 channels 
simultaneously. You need to activate the license as described below before you can use the fax channels. If you 
need more channels for V.17 fax or if you want to use another of the above listed functionalities, you need to 
purchase a license. Contact your Dialogic sales representative for more information. 

To activate your license, you need the following information:

• Device Unique ID (DUID) on page 14

• Proof of Purchase Code (PPC) on page 14

Once you have both, the DUID and the PPC, visit the Dialogic® Diva® Activation site to register your PPC together 
with the DUID and you will receive your license file. Activate this license file in the License Manager of the 
Dialogic® Diva® Configuration Manager. The Diva Configuration Manager is part of the Dialogic® Diva® System 
Release software and allows you to configure your Diva Media Board. For more information about the license 
activation, see To activate the license file on page 15.
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Device Unique ID (DUID)

The DUID binds the license to the installed Dialogic® Diva® Media Board. You can get the DUID from the 
Dialogic® Diva® Configuration Manager as described here:

1. Click Start > Programs > Dialogic Diva > Configuration Manager.

2. In the menu bar, click Tools > License Manager and click Available DUIDs on this system.

3. In the right pane of the dialog box, select the Diva Media Board for which you want to activate a license and 
click Copy DUID to the clipboard.

4. If you need to do the web activation using another computer, open an editor, paste the DUID, and save the file.

Proof of Purchase Code (PPC)

When you purchase the license, you will receive a PPC either in printed form or via email. By registering this 
PPC, you represent and warrant that you lawfully purchased the license.

To register your PPC and DUID

1. Open the following web site: http://www.dialogic.com/activate. 

2. Enter your PPC and click Check.

http://www.dialogic.com/activate/akiweb_reg.asp
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3. If your PPC is valid, the following web site will open:

Paste the Device Unique ID (DUID) that you saved earlier, and enter your email address to which the license 
file should be sent. 

4. Click Activate to generate the license file that will be sent to the email address you have entered.

5. Save the license file and activate it as described below.

To activate the license file

Note:  The date set in the system settings of your computer must be correct. Otherwise, you cannot add your 
license file.

1. Open the Dialogic® Diva® Configuration Manager. To do so, click Start > Programs > Dialogic Diva > 
Configuration Manager.

1. Click Tools > License Manager in the menu bar of the Diva Configuration Manager.

2. Click Add License and go to the directory where you saved the license file.

3. Select the license file and click Open. Your license file is now added to the License Manager.

4. Click Close to close the License Manager.

5. In the Diva Configuration Manager menu bar, click File > Activate to activate the configuration.

6. Now, the fax functionality you acquired with your license is unlocked.
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Basic Configuration

Configure the connection to the PSTN/PBX line in the Dialogic® Diva® Configuration Manager. 

1. Click Start > Programs > Dialogic Diva > Configuration Manager to open the Diva Configuration 
Manager.  

The graphic shows a configuration for a Dialogic® 3008 Media Gateway; therefore, one Dialogic® Diva® 
4BRI-8 Media Board is displayed. 

2. Select a line in the configuration pane to select its options in the propierties pane. 

3. Select the Switch Type to which your gateway is connected, either a PSTN line or a PBX. In the graphic, 
PBX, Q-SIG is selected.

4. Configure additional settings for the line, e.g., for the switch type Q-SIG you can configure the PBX Type 
and configuration settings for the selected PBX. For more information about the settings, see the 
Dialogic® Diva® Configuration Manager Online Help file under Help > Help Topics.

5. When you are finished, close the Diva Configuration Manager. When prompted, activate your configuration.

6. After the configuration is activated, restart your Dialogic® Media Gateway.
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SIP Configuration

The SIP settings are configured in the Dialogic® Diva® SIPcontrolTM software configuration tool. 

Note:  The graphics of the basic SIP configuration show the settings for a Dialogic® 3000 Media Gateway Series.

1. To open the tool, click Start > Programs > Dialogic Diva > SIPcontrol Configuration.

Note:  If you need help configuring the Dialogic® Diva® SIPcontrolTM software settings:

• click the respective parameter in the configuration tool to open a window with the help text, or

• refer to the Dialogic® 3000 and 4000 Media Gateway Series Reference Guide that provides a 
detailed description of all parameters.

2. Under PSTN Interface Configuration, the controllers of the Dialogic® Diva® Media Board are listed and 
enabled by default. Click the check boxes under Enabled to disable the controllers you do not use. See the 
graphics of the Dialogic® Media Gateway rear panels under Installation on page 11 to identify which port 
corresponds to which controller. 

3. Go to Network Interface Configuration and set the SIP Listen Port to: 

• 5060 if:

• you use a Dialogic® 3000 Media Gateway with Microsoft® Exchange Server 2007, or 

• you use a Dialogic® 4000 Media Gateway and the Microsoft® Mediation Server is not installed on the 
Media Gateway.

• 9803 if you use a Dialogic® 4000 Media Gateway and the Microsoft® Mediation Server is installed on the 
Dialogic® Media Gateway.  

Check the Enabled box of your Ethernet adapter.
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4. Configure the SIP peer settings. To do so, click SIP Peer Configuration and then click Add to open the 
Edit SIP Peer Configuration window.

• Enter a name for the SIP peer configuration. 

• Select the peer type, e.g., MS Exchange 2007 for the Dialogic® Media Gateway 3000 Series or MS OCS 

2007 / Mediation Server for the Dialogic® Media Gateway 4000 Series.

• Enable the Default SIP to PSTN peer check box. 

• If you are using a Dialogic® 3000 Media Gateway with Microsoft® Exchange Server 2007, set the Host 

to the IP address of your Unified Messaging server. If you are using the Dialogic® 4000 Media Gateway 
with Microsoft® Office Communications Server 2007, set the Host to the IP address of your Mediation 
Server.

• Leave the other settings at their default values.

Click OK to save the settings and to close the menu.
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5. Configure one routing for PSTN to SIP and one for SIP to PSTN. To do so, click Routing Configuration and 
then click Add to open the Edit Routing Configuration window. 

• For PSTN to SIP, enter a name and select the direction. Select the controller that should be used for this 
routing and the configured SIP peer as Master. Leave the remaining settings at their default values. 

Click OK to save the settings and to close the window.
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• For SIP to PSTN, enter a name and select the direction. Select the SIP peer as source and the controller 
you want to use for this routing as Master. Leave the remaining settings at their default values.

Click OK to save the settings and to close the window.

6. If you have configured all settings, click Save in the main configuration page to save the settings and to 
activate the changes. 

For the settings in other environments, consult the user guide of your respective SIP client.

7. If you use a Microsoft® Mediation Server on the Dialogic 4000 Media Gateway Series go to Enabling the 
Microsoft® Mediation Server on a Dialogic® 4000 Media Gateway Series on page 21, before you start the 
service.
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Enabling the Microsoft® Mediation Server on a Dialogic® 4000 Media Gateway Series

The Dialogic® 4000 Media Gateway is a co-located Media Gateway for Microsoft® Office Communications Server 
(OCS) 2007; therefore, the Microsoft® Mediation Server will be running directly on this device. The device must 
be part of the same domain as the OCS. 

The required steps are:

1. Install the Microsoft OCS 2007 and add the Dialogic 4000 Media Gateway to the same domain of the OCS.

2. Restart the computer and login with the account that has domain administrator rights.

3. Activate the Mediation Server. To do so, open a Dos box and enter:  
C:\Install\Microsoft\Mediationserver-for-DGM4000
and execute the following command: 
lcscmd.exe /MedSrv /Action:Activate /Password:<Password-of-RTCComponentService-Account>

4. If the activation was successful, continue with the configuration of the Mediation Server using the MMC of 
OCS 2007. You will find the MMC under Start > Settings > Control Panel > Administrative Tools > 
Office Communications Server.

5. Request, retrieve, and import a certificate from a CA (Certificate Authority) and add it to the Mediation 
Server. Refer to the OCS 2007 documentation for more information about how to accomplish this. 

Note:  This step needs to be undertaken while you are directly logged on to the Media Gateway. It cannot 
be undertaken using the MMC of the OCS 2007 on another PC in the domain.

6. The remaining configuration steps for setting up the Mediation Server can be done remotely by using the 
MMC of the OCS 2007 on another PC in the domain.
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On the Mediation Server, you need to configure the IP address of the PSTN gateway to ensure proper functioning. 
To do so:

1. Configure the properties of your Mediation Server in the OCS 2007 window. On the General tab, you can 
see the Gateway listening IP address. Annotate this number.

2. Click the Next Hop Connections tab. Under PSTN Gateway next hop, enter the annotated IP address 
and enter the port number of the Dialogic® Diva® SIPcontrolTM software.

3. Click OK to close the dialog box.
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Backing up and Restoring the Configuration of the Dialogic® 4000 Media Gateway 
Series 

The Dialogic® 4000 Media Gateways provide a restore and backup menu. You can access this menu if you press 
the left ALT key during the boot sequence. The menu provides the following options:

Restore to factory defaults: The configuration is set to default factory settings with which the Media Gateway 
was delivered. If you choose this option and you accept to restore the factory defaults, all current settings will 
be lost. 

Create backup: An image of all settings is created and stored under D:/backup. The backup is overwritten 
every time you create a new backup. If you need to keep a backup with certain settings, save it in a different 
directory or on an external medium.

Restore previous backup: With this option, you can restore a previously saved backup. This might be necessary 
if you need re-activate the settings of a configuration you saved earlier. If you choose this option, all current 
settings will be lost. 

Reboot: Restarts the Media Gateway.

If you do not choose any of the settings, the Media Gateway will be restarted after the time displayed at the 
bottom of the dialog box has elapsed.
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LED indicators

The LED indicators are different for the two Dialogic® Media Gateway Series:

• For the Dialogic® 3000 Media Gateway Series, see below.

• For the Dialogic® 4000 Media Gateway Series, see page 24.

LED indicators of the Dialogic® 3000 Media Gateway

The description of the LED in the table corresponds to the description on the front panel of the Media Gateway. 

LED indicators of the Dialogic® 4000 Media Gateway

The following LED indicators and switches are integrated in the front panel of the Media Gateway:  

 

LED Status Description

Power off The gateway is not connected to the power supply.

lit The LED is lit as soon as the power cable is connected.

HDD (hard disk drive) off The hard drive is not accessed.

lit The hard drive is accessed.

Ethernet AC/LNK off No connection is active on this port.

lit A connection is active on this port.

flashing Data is being sent or received. The flashing frequency is proportional to the amount 
of traffic on the network link.

Ethernet Speed off There is no connection to the Ethernet.

green The speed is 10/100 Mbps.

orange The speed is 1 Gbps.

1 Power LED 6 Power Switch

2 Status LED 7 Reset Switch

3 Disk Activity LED 8 NMI Switch

4 NIC Activity LED 9 ID Switch

5 ID LED

LED Color Status Description

1 green off Power off or power source disrupted

lit Power on

2  green lit Normal activity

flashing Degraded operation

orange lit Critical fault

flashing Non-critical fault

3 green lit HDD activity

orange lit HDD fault (non-critical)

red lit Critical fault

4 green lit No fault

5 blue lit Used to identify a particular system
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Technical Specifications

Environmental requirement:

Operating temperature: 10 degrees Celsius to 35 degrees Celsius

Replacing a power supply module

To replace the power supply module (PSM), do the following:

1. If you have two power supply modules, verify which one has failed. The LED next to the green handle is lit 
red if the PSM failed.

2. Disconnect the power cord.

Note:  You only need to disconnect the power cord of the PSM that failed. The power cord of the functioning 
PSM can remain plugged.

3. Slide the green safety lock to the left.

4. Grasp the green handle and pull the PSM out.

5. Take the new PSM and insert it into the box. Make sure to keep the green safety lock pressed to the left 
while inserting the PSM.

Dialogic® 3000 Media Gateways Dialogic® 4000 Media Gateways

CPU Intel Pentium IV processor; 2.8 GHz Intel Xeon 5160 Dual Core processor; 3.0GHz 

Memory 1 GB DDR SDRAM (400MHz) 2 GB DDR2 ECC SDRAM (667MHz) 

Dimensions in mm  

Height: 44 44

Width: 430 430

Length: 390 508

External interface 2 USB (2.0) ports
VGA port

RS232 Serial port 

2 x Gigabit-Ethernet ports

3 USB (2.0) ports
VGA port

RS232 Serial port 

4 x Gigabit-Ethernet ports

Internal interface 32 bit; PCI (5 V) 64 bit; PCI (3.3 V)

Power supply 100-240 Vac

50/60 Hz

4 A

2 power supplies; each with:

100-240 Vac

50/60 Hz

4/2 A
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International Regulatory Information

Note:  The FCC statements and the regulatory information for Canada are only valid for the Dialogic® 4000 
Media Gateway.

Regulatory Information for Europe  

EU Declaration of Conformity

Dialogic Corporation declares that this equipment is in compliance with the Radio and Telecommunication 
Terminal Equipment directive 1999/5/EC with requirements covering the Electromagnetic Compatibility Directive 
89/336/EEC and the Low Voltage Directive 2006/95/EC. A detailed declaration of conformity for this product can 
be found at: http://www.dialogic.com/declarations

CS:Dialogic tímto prohlašuje, že tento ITE je ve shodě se základními požadavky a dalšími příslusnými ustanoveními směrnice 
1999/5/ES.

DA:Undertegnede Dialogic erklærer herved, at følgende udstyr ITE overholder de væsentlige krav og øvrige 
relevante krav i direktiv 1999/5/EF.

DE: Hiermit erklärt Dialogic, dass sich das Gerät ITE in Übereinstimmung mit den grundlegenden Anforderungen 
und den übrigen relevanten Bestimmungen der Richtlinie 1999/5/EG befindet. 

EL:Ã≈ ‘«Õ —¡–œ’”¡ Dialogic ƒ«ÀŸÕ≈… œ‘… …‘≈ ”’ÃÃœ–÷ŸÕ≈‘¡… —–œ” ‘…” œ’”…Ÿƒ≈…” ¡—¡…‘«”≈…”  ¡… ‘…” Àœ…—≈” 

”◊≈‘… ≈” ƒ…¡‘¡Œ≈…” ‘«” œƒ«√…¡” 1999/5/EK.

EN:Hereby, Dialogic, declares that this ITE is in compliance with the essential requirements and other relevant 
provisions of Directive 1999/5/EC.

ES:Por medio de la presente Dialogic declara que el ITE cumple con los requisitos esenciales y cualesquiera otras 
disposiciones aplicables o exigibles de la Directiva 1999/5/EC.

ET:Käesolevaga kinnitab Dialogic seadme ITE vastavust direktiivi 1999/5/EÜ põhinõuetele ja nimetatud 
direktiivist tulenevatele teistele asjakohastele sätetele.

FI:Dialogic vakuuttaa täten että ITE tyyppinen laite on direktiivin 1999/5/EY oleellisten vaatimusten ja sitä 
koskevien diretiivin muiden ehtojen mukainen.

FR:Par la présente Dialogic déclare que l’appareil ITE est conforme aux exigences essentielles et aux autres 
dispositions pertinentes de la directive 1999/5/CE.

HU:Alulírott, Dialogic nyilatkozom, hogy a ITE megfelel a vonatkozó alapvetõ követelményeknek és az 1999/5/EC 
irányelv egyéb elõírásainak.

IC:Hér með lýsir Dialogic yfir því að ITE er í samræmi við grunnkröfur og aðrar kröfur, sem gerðar eru í tilskipun 
1999/5/EC.

IT:Con la presente Dialogic dichiara che questo ITE è conforme ai requisiti essenziali ed alle altre disposizioni 
pertinenti stabilite dalla direttiva 1999/5/CE.

LT:Šiuo Dialogic deklaruoja, kad šis ITE atitinka esminius reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas. 

LV:Ar šo Dialogic deklarē, ka ITE atbilst Direktîvas 1999/5/EK bûtiskajâm prasîbâm un citiem ar to saistîtajiem noteikumiem.

NL:Hierbij verklaart Dialogic dat het toestel ITE in overeenstemming is met de essentiële eisen en de andere 
relevante bepalingen van richtlijn 1999/5/EG. 

WARNING This is a class A product. In a domestic environment this product may cause radio interference 
in which case the user may be required to take adequate measures.

http://www.dialogic.com/declarations
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NO:Dialogic erklærer herved at utstyret ITE er i samsvar med de grunnleggende krav og øvrige relevante krav 
i direktiv 1999/5/EF.

PL:Dialogic niniejszym oświadcza, że ITE spełnia wszystkie istotne wymagania i odpowiednie ustalenia dyrektywy 1999/5/EC. 

PT:Dialogic declara que este ITE está conforme com os requisitos essenciais e outras disposições da Directiva 
1999/5/CE.

SL:Dialogic izjavlja, da je ta ITE v skladu z bistvenimi zahtevami in ostalimi relevantnimi določili direktive 1999/5/ES.

SK:Dialogic týmto vyhlasuje, že ITE spĺňa základné požiadavky a všetky príslušné ustanovenia Smernice 1999/5/ES.

SV:Härmed intygar Dialogic att denna ITE står l överensstämmelse med de väsentliga egenskapskrav och övriga 
relevanta bestämmelser som framgår av direktiv 1999/5/EG.
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Regulatory Information for the USA

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

(1) this device may not cause harmful interference, and 

(2) this device must accept any interference received, including interference that may cause undesired operation.

For questions related to the EMC performance of this product, contact:

Dialogic
1515 Route 10
Parsippany
NJ 07054
Tel: (973) 967-6000

FCC Part 15 Statement

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to correct the interference at his own expense.

FCC Part 68 Notice

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA.

On the bottom of this equipment is a label that contains, among other information, a FCC part 68 registration 
number or a product identifier in the format US: AAAEQ##TXXXX. If requested, this information must be provided 
to the telephone company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with 
the applicable FCC part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular 
plug is provided with this product. It is designed to be connected to a compatible modular jack that is also 
compliant.

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs 
on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all 
areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected 
to a line, as determined by the total RENs, contact the local telephone company.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that 
temporary discontinuance of service may be required. But if advance notice is not practical, the telephone 
company will notify the customer as soon as possible. Also, you will be advised of your right to file a complaint 
with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations, or procedures that could 
affect the operation of the equipment. If this happens, the telephone company will provide advance notice in 
order for you to make the necessary modifications in order to maintain uninterrupted service.

If trouble is experienced with this equipment, please contact us for repair and warranty information. If the trouble 
is causing harm to the telephone network, the telephone company may request you to remove the equipment 
from the network until the problem is resolved.

This unit contains no user-serviceable parts.

Connection to party lines is subject to state tariffs. Contact the state public utility commission, public service 
commission or corporation commission for information.

WARNING: Changes or modifications to this unit not expressly approved by Dialogic Corporation could void the user's 
authority to operate the equipment.
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Dialogic® Diva® Primary Rate Interface (PRI) Media Boards:

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device to send any message via a telephone fax machine unless such message clearly contains in a 
margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time 
it is sent and an identification of the business or other entity, or other individual sending the message and the 
telephone number of the sending machine or such business, other entity, or individual. The telephone number 
provided may not be a 900 number or any other number for which charges exceed local or long-distance 
transmission charges. 

It is the responsibility of the end user or developer to ensure that the regulations set forth in the preceding 
paragraph are followed. Application developers must provide support for fax branding in the applications they 
develop and inform users of their responsibility under the Act along with instructions for use. Developers can 
find instructions for setting up a fax header in the Dialogic® software reference manual. End users should consult 
the documentation that is provided with their computer telephony application for instructions on fax branding 
identification.

Regulatory Information for Canada

Notice: This equipment meets the applicable Industry Canada Terminal Equipment Technical Specifications.

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

International Approvals

To receive detailed approval information, send a request specifying the product name and the relevant countries 
to the following E-mail address:
certifications@dialogic.com

All Dialogic® 3000 and 4000 Media Gateways are certified in Europe (  mark).

Approval in Europe includes only countries that accept European Union approval ( mark): Austria, Belgium, 
Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, Hungary, Iceland, Ireland, Italy, 
Latvia, Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Slovakia, Slovenia, Spain, Sweden, 
Switzerland, and United Kingdom. 

Some other countries in Eastern Europe and the Mediterranean region also accept the CE-mark. If you are 
unsure, please check with your equipment supplier, service provider or regulatory authority for confirmation.

Facility Interface code Digital Reg. code Service Order code USOC Jack Type

04DU9-1SN DD 6.0F RJ48-C
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Your Dialogic® 3000 and 4000 Media Gateway and the WEEE Directive

In August 2005, the European Union Directive on Waste Electrical and Electronic Equipment (2002/96/EC) and 
its amendment (2003/108/EC), collectively known as the WEEE Directive, came into force throughout most of 
the European Union. This Dialogic product comes within the scope of the WEEE Directive.

We are confident that this product will provide you with many years of reliable service. Moreover, we are pleased 
to advise you that Dialogic warrants this product, as detailed in the Dialogic Corporation End User Hardware 
Product(s) Warranty Statement on page 5, and provides a fee based repair service when the product is out of 
warranty. However, a time will come when the product will no longer meet your needs or will become uneconomic 
to repair. It is at that stage that we ask for your co-operation in recycling this product in the spirit of the WEEE 
directive.

Dialogic has taken great care to minimize the environmental burden of this product by careful design, and 
manufacturing it under an Environmental Management System, registered to ISO 14001. The requirements of 
ISO 14001 are similar to and as rigorous as the requirements of ISO 9001, Quality Management Systems with 
which you may be more familiar. We ask you to help us to ensure that the environmental burden of this product 
is minimized when it is of no further use to you by recycling it.

Like all electrical and electronic equipment, including televisions and computers, it may contain small amounts 
of materials which could lead to environmental damage. To minimize any environmental damage we ask you to 
have this product recycled by:

• bringing it to the recycling collection point in your company

• handing it into the store where you are purchasing the replacement

• delivering it to a local bring-center in your area

No charge can be imposed on you for this recycling service in the European Union, as Dialogic has paid for 
recycling this product when it was placed on the market. These are requirements of the WEEE directive.

We thank you in advance for you co-operation and working with Dialogic in protecting our environment.

Please do not dispose of this product 
through municipal or general waste, 
recycle it.
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Suppliers Declaration of Conformity

 

Declaration of Conformity
No: D0018 

Revision 01 

 
The equipment described below is declared to be in conformity with the following applicable national and international standards. The 
conformity is valid ONLY when the equipment is used in a manner consistent with the manufacturer’s recommendations and the 
reference documents. 

 
 

Equipment Type(s):   Diva 2-PRI, V-2PRI 
 Diva 4-PRI, V-4PRI  

 
 
 

Document No / Edition /Date Title 

IEC 60950-1: 2001 Safety of Information Technology Equipment 

UL/CSA 60950-1 – 1
st
 Edition (2003) Safety of Information Technology Equipment 

EN 60950-1: 2001 Safety of Information Technology Equipment 

FCC, 47 CFR Part 15, Class B digital device Radio Frequency Devices - Subpart B - Unintentional Radiators 

ICES-003 Issue 4 - Feb 2004, Class B Interference-Causing Equipment Standards - Digital Apparatus 

EN 55022: 1998, Class B Limit Information Technology Equipment - Radio Disturbance Characteristics 

EN 55024: 1998 Information Technology Equipment - Immunity Characteristics 

TIA-968-A: Oct 2002, A1: July 2003, A2: Jan 
2003, A3: Dec 9, 2004 

Technical Requirements for Connection of Terminal Equipment to the Telephone Network 

CS-03 Issue 9 Part VI: Nov 2004 Specification for Terminal Equipment, Terminal Systems, Network Protection Devices, Connection Arrangements 

TBR4: Nov 95, A1: Dec 97 Attachment requirements for terminal equipment to connect to an ISDN using ISDN primary rate access

AS/NZS 60950: 2000, A1: 2003 Safety of Information Technology Equipment 

AS/ACIF S038: 2001 Requirements for ISDN Primary Rate Access Interface 

 

Additional information:  

  
Australia test reports: Futjisu/Siemens report CER+EIC04-0004+E01, dated 26/10/2004 covers EN55022 

 Futjisu/Siemens report CER+EIC06-0005+S01, dated 11/07/2004 covers AS/NZS 60950 

 Eicon internal report, dated 19/01/2006 and TBR4 layer 1 report # 3-4143-1-2/04 from Cetecom, dated 
03/11/2004 and layer 2, 3 report 98/164/HJ from Deutsche Telekom AG, dated 30/07/1998 covers AS/ACIF S038 

  

 
 
  
 

Regions: 
 

European Economic Area (EEA): Dialogic Corporation (address below) declares the equipment in compliance with the essential requirements of EC Council 
Directives: 1999/5/EC - R&TTE: 2006/95/EC - Safety/LVD: 89/336/EEC – EMC 

USA: Dialogic Corporation (address below) make this SDoC as Responsible Party for equipment registered with ACTA as number: US: E3SDDNAN800-820 

Canada: Dialogic Corporation (address below) is the Declaring Party for equipment registered with Industry Canada as number: IC: 885E-803016 

Australia / New Zealand: Supplier Code N964 [Dialogic Pty Ltd.  Level 12, 1 Pacific Highway North Sydney NSW 2060] ACN: 064 824 899 

Any other region where the Regulatory Requirements are satisfied by compliance to the standards declared above. 

 
 

This Declaration of Conformity is issued by Dialogic Corporation, which is solely responsible for the declared compliance. 
Company Address: 
 

Dialogic Corporation  
9800 Cavendish 5

th
 floor 

Montreal, Quebec  
Canada, H4M 2V9 

Authorized signature, name and function: 
 
 
 
        Gaetan Hogue  -  Appro als Manager v
        Date:  25, January, 2007 

 
Dialogic Distribution Limited, our location in Europe operates from: 

Unit 4034 Kingswood Avenue Citywest Business Campus, Saggart, Co. Dublin, Ireland. 
 

 
 
Copies of this Declaration of Conformity may be downloaded at http://www.dialogic.com/declarations
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